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The Office 2007 interface has many differences from the 2003 version, with the main functional differences outlined 
in this packet. Individual packets for Office 2007 programs including Excel, PowerPoint and Word 2007 are available 
from the Staff Learning Computer Training Handouts page (http://www.lib.umd.edu/groups/learning/handouts.html). 
For a comparison of commands between Office 2003 and Office 2007, see the "Office 2007 Guide to Frequently 
Used Commands" available in the Office 2007 section of the Computer Training Handouts page. 
 
 
HHHeeelllpppfffuuulll    OOOffffff iiiccceee   KKKeeeyyybbboooaaarrrddd   SSShhhooorrrtttcccuuutttsss   
 
As you become more familiar with Office 2007, you will use the Microsoft Office Ribbon as you work with your files. 
However, a number of keyboard shortcuts continue to work in Office 2007 that can save you time: 
   

CTRL+O    Open    
CTRL+Z    Undo    
CTRL+Y    Redo. In some cases, if there is nothing to redo, this repeats the last action.    
CTRL+S    Save    
CTRL+P    Activates the Print menu.    
ALT+F4    Closes the active window. You will be prompted to save your document before closing 

if necessary.    
CTRL+B    Bolds highlighted text    
CTRL+I    Italicizes highlighted text    
CTRL+U    Underlines highlighted text    
CTRL+R    Align text right    
CTRL+E    Align text center    
CTRL+L    Align text left    
CTRL+C    Copy    
CTRL+X    Cut    
CTRL+V    Paste    
CTRL+F    Find    
CTRL+H    Replace    

   
   
TTThhheee   OOOffffff iiiccceee   222000000777   EEEnnnvvviii rrrooonnnmmmeeennnttt    
 
The best way to start learning the new features of Office 2007 is by starting each of the programs and examining 
them. A majority of this packet is based upon Word 2007, although examples for other Office programs have also 
been incorporated.  
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The graphic to the right 
highlights some of the major 
changes in the new Word 
interface:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
Title Bar  
   
At the top of the window is a blue bar called the title bar.  The title bar contains the name of the application 
(Microsoft Excel, Word, etc.) and the name of the file in which you are working. (NOTE:  Files are automatically titled 
“Book 1” in Excel, “Presentation1” in PowerPoint, or “Document 1” in Word until they are renamed). The title bar also 
includes the minimize/ maximize, restore, and close buttons .  Near the title bar are the Office Button, 
Quick Access Toolbar, and the Office Ribbon, all of which are new to Office 2007.   
 
Microsoft Office Button 

The Microsoft Office Button   groups together commands that are related to managing the Office program 
and the file with which you are working.  The Office Button replaces the File menu found in previous versions of 
Microsoft Office. When you select the Office Button, you will see a listing of basic options on the left-hand side of the 
menu. In Word, these options are:  
 

 
Create a new document. 

 
Open an existing document. 

 
Convert your document to a Microsoft XML file, or convert a document in an earlier version 
of Word to Word 2007 format. 

 
Save your file in the default (Microsoft 2007) format. 

 
Provides options to save your file in the standard (default) format, or as a template or 
Office 97-2003 document. 
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Provides print options – including print preview. 

 
Provides options to allow you to prepare a document for distribution, including checking for 
compatibility with earlier versions of Word or restricting access to a document. 

 
Allows documents to be e-mailed or faxed online. 

 
Provides advanced options for distributing documents via a blog or shared workspace. 

 
Closes the current open document. If changes have been made prior to closing – you will 
be prompted to save your document before closing. 

 
Displays the Word Options menu, allowing you to customize Word features such as 
autocorrect or document display options. 

 
Closes Microsoft Word. (NOTE: The close button  on the title bar can also be used to 
close your Word session.)  

 
Note: The Office Button menus for Access, Excel and PowerPoint have slightly different options on their Office 
Button lists. These include: 
 
Access Excel PowerPoint 

Allows 
you to 
perform 

routine maintenance on your 
database and set basic properties for 
your database. 

Allows you to 
save a file in 
Macro-

enabled, Binary, Office 97-2003 
formats or in the default Office 2007 
format.   

Provides 
advanced 
options for 

distribution including packaging a 
presentation for CD or creating 
handouts in Microsoft Word.  

 
On the right hand side of the Office Button menu you will see a list of Recent Documents. After you have created, 
viewed or edited a document in Office 2007, its name will appear in the Recent Document s list for easy access.  A 
document can be permanently listed in Recent Documents 
by selecting the pushpin icon  next to the filename. 
Once selected, the pushpin icon will change to a “pinned” 
position  . “Pinned” documents may be unselected by 
clicking on the  pushpin icon. 
 
 
Quick Access Toolbar 
 

The Quick Access Toolbar  appears next to the Office Button and initially contains the save, 
redo and undo functions. As you work with Office 2007, you may find that you use certain commands more frequently 
than others. You can customize the toolbar by selecting the  icon to add additional functions (such as close file). 
You can also choose to minimize the Office Ribbon.   
 
(NOTE: Minimizing the Office Ribbon is not recommended unless you are extremely familiar with Office keyboard 
commands.) 
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Microsoft Office Ribbon 
 
The Microsoft Office Ribbon replaces the Menu bar/tool bar from earlier editions of Microsoft Office, and is another 
one of the major design changes in Office 2007.  The Office Ribbon contains commands you will use with various 
Office products, personalized for each program. On the Ribbon, you will find commands grouped by function. When 
you open an existing document or create a new document – the Office Ribbon will appear with the Home tab active:  
 

 
 
On the Home tab in Word, you will find commands arranged in five “groups”: Clipboard, Font, Paragraph, Styles, and 
Editing. To see what a particular Ribbon button does, pause your mouse pointer over the button and a brief 
description will appear.  
 
Additional tabs that appear in the Word Ribbon are: 
 Insert – commands for Pages, Tables, Illustrations, Links, Headers and Footers, Text and Symbols: 
 Page Layout –commands grouped for Document Themes, Page Setup, Page Background, Paragraph Setup and 

Image Arrangement.  
 References - items on this tab are designed to assist you in creating longer documents – and allow you to insert 

such items as endnotes, cross-references or an index.   
 Mailings - commands are grouped on this tab to assist you in creating mass mailings, envelopes and labels.  
 Review - provides options for proofing, commenting and comparing documents. You can also choose to 

password protect a document from this tab 
 View - commands grouped on this tab allow you to select document views, show and hide gridlines or rulers, 

zoom text, arrange document windows or view and record macros.  
 
If you have additional helper applications on your computer (such as Documents to Go for a Palm device) - you may 
access commands for those programs from the Add-Ins tab.  
 
Additional tabs will appear as you work with files. Some will appear when you insert or select a table, chart, slide, 
picture or drawing. Others will appear when you select a command such as print preview. 
  
Status Bar 
   
At the bottom of the screen you will see the status bar, which displays information to keep you informed as to the 
current state of your Office file. For example, in Word, the status bar provides the page number and word count for 
your document, as well as the proofing indicator. If there are no grammatical or spelling errors in your document, the 
check    icon appears, whereas the error   icon will appear if proofing errors were found.  
 
On the right corner of the status bar are icons associated with various views in which you can display your file. For 
example, in Word, there are five icons . Starting from the left to right, the icons are: print layout, full 
screen reading, web layout, outline view, and draft view.  
 
You can also zoom in and out of your file by selecting the zoom indicator  at the 
right end of the status bar. 
 
To customize the status bar (to display such features as caps lock or remove features such as word count), right click 
on the status bar and select the option from the menu that appears. 
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OOOffffff iiiccceee   LLLiiivvveee   PPPrrreeevvviiieeewww   aaannnddd   MMMiiinnniii    TTToooooolllbbbaaarrr 
   
Two of the newest features in Office 2007 include live preview and the mini toolbar. Both of these are designed to 
assist you with document previewing and formatting. The Live Preview feature temporarily applies formatting on any 
text or object you have selected, when you hover your mouse over a formatting button. This allows you to have a 
“sneak peek” of how the option would affect the appearance of the object, without actually applying it. The temporary 
formatting is removed when the mouse pointer is moved from the button. 
 
In addition to Live Preview, you will likely encounter the Mini Toolbar as you enter text 
in PowerPoint presentations and Word documents. When you highlight text you have 
typed in these applications, the Mini Toolbar will start to appear as a transparent box 
above the selected text. As you move your mouse toward the mini toolbar, it becomes more visible and can be used 
to select several common formatting options.  (NOTE: You can also make formatting changes from the Ribbon 
options.) If you ignore the mini toolbar, it will disappear when you continue working. 
 
HELPFUL HINT: If you do not wish to have the Live Preview and/or Mini Toolbar 
features active while you are working in Word or PowerPoint, you may turn off one or 
both of these features by going to the Office Button, and choosing Word (or 
PowerPoint) Options  Popular and unselecting the appropriate check box(es).  
 
   
CCCooommmpppaaattt iiibbbiii lll iii tttyyy   MMMooodddeee   iiinnn   OOOffffff iiiccceee   222000000777    
 
When you open a document in Office 2007 that was created in an earlier version of Office, a function called 
Compatibility Mode is activated. When this happens, the words [Compatibility Mode] will appear in the title bar of the 
document window, as in the example below:  

 
 

Compatibility Mode ensures that no new or enhanced features available in Office 2007 are applied while you are 
working with a document, workbook, presentation or database, so that people who are using previous versions of 
Office will have full editing capabilities.  
 
You can choose to work in Compatibility Mode, or you can convert your document to Office 2007 file format. To do 
this, select the Convert  option from the Microsoft Office Button. Converting a document allows you to access Office 
2007 features. However, individuals who are using previous versions of Office may be prevented from or have 
difficulty editing certain portions of the document that were created by using new or enhanced features available in 
Office 2007.  
 
If you think your file may be viewed by individuals who do not have access to Office 2007, you will want to save it in 
an earlier version.  (Important Note: PowerPoint 2007 does not support saving to PowerPoint 95 or earlier file 
formats.) When you save an Office 97–2003 file in Office 2007 format, Compatibility Mode is automatically turned off 
(except in Word – which gives you the option to select the Maintain compatibility with Word 97–2003 check box in 
the Save As dialog box).  
 
To determine whether or not features within a file you create in Office 
2007 are compatible with earlier versions, use the Compatibility Checker 
– available within the Prepare option in the Microsoft Office Button. If 
compatibility issues arise – you will receive an explanation of what they 
are and the potential impact, as seen in the image to the right:  
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TTThhheeemmmeeesss      
 
A theme is a set of unified design elements and color schemes. Every document that you create in Excel, Word or 
PowerPoint 2007 has a theme inside it — even brand new documents. The themes in these three programs are the 
same – so you could create a Word file, PowerPoint presentation and Excel workbook using the same theme. The 
default theme is Office Theme, which appears as a white background and dark, subtle colors. When you apply a new 
theme, Office Theme is replaced by the new look. Themes themselves encompass such elements as fonts, font 
colors, background colors, body text and heading sizes and list formatting. All content (such as text, tables, and 
SmartArt graphics) is dynamically linked to the theme, so changing the theme automatically changes the look of your 
content. 
 
In Word and Excel, the themes group of options is located in the Page Layout Tab, and appears as 
in the illustration to the right: 
 
In PowerPoint, the themes options are accessible from the Design Tab, and appear as seen in the 
illustration below: 
 

 
 
To apply a theme to your document, click the Themes icon.  To try different themes, rest your pointer over a 
thumbnail in the Themes gallery. The theme will be temporarily applied to any text you already have in a document 
as a result of Live Preview. Once you find a theme you wish to apply, release the mouse button. 
 
IMPORTANT NOTE: If you are working on a file and are in Compatibility Mode, you will not be able to access theme 
options. 
 
If you do not find a theme that you wish to use amongst the preformatted options, you can either search for and 
download additional themes from Microsoft Office Online, or customize a theme to your liking. (NOTE: You can also 
save a custom theme for use in future documents.) To search for additional themes, select Themes, and then click 
More Themes on Microsoft Office Online.  
   
   
SSSaaavvviiinnnggg   YYYooouuurrr    WWWooorrrkkk   
   
When you are creating and editing files – you will want to be sure to periodically save your work. To do this, you may 

either:  

• Use the Save  option from the Quick Access Toolbar  . 
• Use the Save or Save As options accessible from the Office Button. 

o NOTE: The Save As feature includes options that will allow you to save your document as a 
document template or as an Office 97-2003 document.  

• Use the CTRL+S keyboard shortcut. 
 
If you have edited your document after saving it, you will also be prompted to save your document when you choose 
the Exit feature from the Office Button or select the close button  at the top of the title bar. 
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Helpful Hint: Word also has an autosave feature that will periodically back up your document in case the program 
stops responding. The default for autosave is 10 minutes. If you wish to change the autosave interval, you can do so 
by clicking on the Office Button, going to Word Options, and selecting the Save tab.  Change the default setting as 
desired and click OK. 
   
 
 
 
PPPrrr iiinnnttt iiinnnggg   
   
To print your document, choose the Office Button, and select Print. 
Three options will appear. 
 

• To print a specified number of copies or to select a particular 
printer, choose the Print option. 

• To send one copy of your document to the default printer – 
select Quick Print. 

• To review your document prior to sending it to the printer, and 
make needed changes to margins and document layout, select Print Preview. When you are satisfied with 
the layout of your document – select Print, or if you wish to make changes to your document before printing 
– select Close Print Preview to return to your original document. 

   
   
   
AAAcccccceeessssssiiinnnggg   HHHeeelllppp      
 
To access help features within Office 2007 programs, click on the Help 

button  at the upper-right corner of the Microsoft Ribbon, or press F1. 
The Help window will appear, customized for the program in which you 
are working. You can either browse the help menu for assistance with a 
topic, or type in a keyword or phrase in the Search box  

, located at the top of 
the Help box and click Search. Your search results will appear in the 
bottom half of the help box. Click on the appropriate link.  
 
To print a help topic, click on the Print icon  in the Help window.  The 
default setting for the Help window is to remain visible on top of other 

windows. To change this feature, click on the Keep On Top icon  so 

that it appears as a pushpin on its side . Click on the sideways icon 
(Not On Top) to return to the default  “Keep on Top” setting. 

Alternatively, you may select the minimize  icon from the top right 
corner of the help window. To close the help window – click on the Close  icon at the upper right-corner of the 
Help window. 
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AAAddddddiii ttt iiiooonnnaaalll    RRReeesssooouuurrrccceeesss   
   
If you are interested in learning more about Office 2007, there are two titles available for you to check out from the 
Learning Curriculum Resource Library: 

 
Cox, Joyce, et al. Step by Step 2007 Microsoft Office System. Redmond, WA: Microsoft, 2007.  
 
Perry, Greg.  Microsoft Office 2007 All In One.  Indianapolis, IN: Sams, 2007. 

 
A complete listing of titles in the Learning Curriculum Resource Library is available at: 

http://www.lib.umd.edu/groups/learning/lcrlibrary.html  
 
You may also wish to consult these online guides to Office 2007:  
 
The Office 2007 Environment. University of Wisconsin – Eau Claire. 
http://www.uwec.edu/help/Office07/environment.htm.  
 
Microsoft Office 2007 Common Features. University of Wisconsin – Eau Claire. 
http://www.uwec.edu/help/office07.htm  
 
Microsoft Office Training Home Page. http://office.microsoft.com/training              
 
 
As well as the Staff Learning Computer Training Handouts Page, available at: 
http://www.lib.umd.edu/groups/learning/handouts.html.  
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